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GENERAL TIPS 
• Because you will probably want to change things as work progresses, working 

non-destructively will make things much simpler 

• Where possible, use layers and adjustment layers and layer masks to make any 

changes so you can always edit your changes later 

• Get used to working whilst zoomed in! I usually open a second window on the image 

(Window > Arrange > New window for…) and split the screen (Window > Arrange > 

2-up…) to have one at full-image zoom as a reference 

• You are probably going to end up with a lot of layers, so get into the habit of naming 

them and using Layer Groups (folders) 

• Learn any keyboard shortcuts for the tools you use a lot as they will massively speed 

up the process 

• A graphics tablet will make it quicker, easier, and more precise when making any fine 

adjustments 

SCANNING INTO PHOTOSHOP 

The first thing to do is get the image into Photoshop. In my experience, older photographs 

are often much smaller than today’s, so I usually plan to get the image in at a size that will 

allow me to resize it as needed. 

I generally aim to have the final image at 300ppi (the usual resolution for prints), so the first 

thing I look at is the size of the original image. For example, if the original is 3in tall and I want 

it to be 12in (4x its original height) then I will scan it at 300ppi x4, so 1200ppi (or as close as I 

can get). 

STRAIGHTENING, CROPPING, AND RESIZING 

Once in Photoshop I will next crop and straighten the image if needed. 

 

1. In the Tools panel, select the Crop Tool, or press C to activate it 

2. In the Options Bar (at the top of screen), click Straighten 

Click-and-drag along something in the image that should be straight – Photoshop will 

straighten the image accordingly (TIP: this can be used multiple times if necessary) 

3. Enter the desired dimensions and resolution into the Options Bar and drag the crop 

box as required – Photoshop will resize and crop at the same time 

4. When you are happy, click the ‘tick’ (Commit) icon, or press Enter 

SHARPENING 

As most older photographs will look soft to our modern expectations, I tend to apply some 

sharpening. Photoshop has many methods, and I will usually experiment until I find the one 

that gives me the best result for that image. When I sharpen will depend on the state of the 

image – if it needs a lot of repair work doing, then I’ll sharpen after that has been done. 
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I start by converting the layer to a Smart Object – this means that I can go back later and 

adjust the settings if I wish. I will then sharpen it with whichever tool I have settled on 

(usually either Unsharp Mask, Smart Sharpen, or High-Pass Filter). 

In this example, I will use the Unsharp Mask: 

1. Click Filter > Convert for Smart Filters – the layer will change in the Layers panel to 

denote it is a Smart Object 

2. Click Filter > Sharpen > Unsharp Mask… 

3. Click-and-drag the sliders until the image looks good, and click OK 

Because it is a Smart Object, double-click the name of the filter in the Layers panel to adjust 

the settings 

CLEANING AND RETOUCHING 

Now that the image is the correct size, resolution and sharp, it can now be cleaned and 

retouched. As Photoshop has many tools and they cannot all be covered here, the ones I 

usually start with are the Spot Healing Brush Tool and the Patch Tool. 

SPOT HEALING BRUSH TOOL 

I always make any sort of repairs on a separate layer if possible so that I have got more 

flexibility if needed. 

1. At the bottom of the Layers panel, click Create New Layer to add a blank layer above 

the current one 

2. In the Tools panel, select the Spot Healing Brush Tool 

3. In the Options Bar at the top of the screen, ensure Sample All Layers is ticked so that 

the blank layer can be used to repair the other layer in the file 

4. Click, or click-and-drag across any marks to be repaired (TIP: try not to cross lines and 

edges as the Spot Healing Brush will probably smudge them) 

5. If any changes need to be removed, either undo them or use the Eraser Tool on the 

healing layer to erase them 

PATCH TOOL 

As with the Spot Healing Brush Tool, it is worth using the Patch Tool on a layer. This can be 

the same as the Spot Healing Brush layer if you wish, but ideally not the same layer as the 

original image. 

1. In the Tools panel, select the Patch Tool (usually nested with the Spot Healing Brush) 

2. In the Options Bar, change the ‘Patch’ mode to Content-Aware and tick Sample All 

Layers 

3. Click-and-drag around the area to be fixed to select it 

4. Move the mouse inside the area – the pointer will change to display a ‘patch’ 

5. Click-and-drag the area to part of the image to use to repair the area – when you let 

go, the area will be copied and blended into the area to repair 
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RECOLOURING 

The basic process is quite simple, if possibly very repetitive depending on the image, and uses 

a combination of adjustment layers, blending modes, layer masks and selections. 

LAYER MASKS 

As layer masks are essential to this process then there are some things about them that are 

worth knowing: 

• They comprise areas that are black or white – if the mask is black, its effect is hidden; 

if white, its effect is visible (“black conceals, white reveals”) 

• A mask can be created using selections, or by painting using the Brush Tool with 

either a black or white brush 

GETTING STARTED 

Depending on the image, it may be necessary to remove any colour, such as a sepia effect, 

from it before recolouring as this could distort the colours used: 

1. At the bottom of the Layers panel, click Create a new fill or adjustment layer (the 

‘split-circle’) > Hue/Saturation… 

2. In the Properties panel, drag the Saturation slider all the way to the left to remove 

any existing colour tint 

APPLING A COLOUR USING A SELECTION 

1. Start by selecting the area to be recoloured first – any of Photoshop’s selection tools 

can be used 

2. In the Options Bar, click Select and Mask… (or Refine Edge, depending on your 

version of Photoshop) 

3. Feather the edge a little (usually a couple of pixels is enough), and you may wish to 

Smooth the edge too), and click OK 

4. At the bottom of the Layers panel, click Create a new fill or adjustment layer (the 

‘split-circle’) > Solid Color… 

5. In the ‘Color Picker’ dialog box, select a starting colour (this can always be changed 

later) and click OK – the new adjustment layer will be created with a layer mask 

already applied 

6. At the top of the Layers panel, change the ‘Blending Mode’ to either Overlay, Soft 

Light or Color, whichever gives the best result 

APPLYING A COLOUR WITHOUT A SELECTION 

1. At the bottom of the Layers panel, click Create a new fill or adjustment layer (the 

‘split-circle’) > Solid Color… 

2. In the ‘Color Picker’ dialog box, select a starting colour (this can always be changed 

later) and click OK – the new adjustment layer will be created with a layer mask 

already applied 

3. At the top of the Layers panel, change the ‘Blending Mode’ to either Overlay, Soft 

Light or Color, whichever gives the best result 

4. With the layer mask selected, click Edit > Fill… 
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5. In the ‘Fill’ dialog box, ensure that black is selected and click OK – this will fill the 

mask with black and hide the effect completely 

6. In the Tools panel, select the Brush Tool or press B to activate it 

7. Ensure that white is set as the foreground colour, and with the mask selected in the 

Layers panel, paint the effect in where it is needed 

CHANGING A COLOURED LAYER 

If the colour needs to be changed: 

1. Double-click its thumbnail in the Layers panel to open the ‘Color Picker’ dialog box 

2. Select a new colour and click OK 

If its layer mask needs to be edited: 

1. In the Tools panel, select the Brush Tool or press B to activate it 

2. Ensure that the foreground and background colours are set to the defaults of black 

and white – press D 

3. If necessary, press X to switch the fore/background colours over 

4. In the Layers panel, ensure that the layer mask is selected (it will appear with a ‘frame’ 

around it), not the layer thumbnail 

5. Paint black or white onto the mask to hide or reveal the colour 

If the colour is correct, but seems too ‘strong’, at the top of the Layers panel, adjust the 

Opacity setting as desired 

NAMING AND GROUPING LAYERS 

As you will likely end up with many layers, it can be worthwhile naming and grouping them to 

help you work later. 

To name a layer: 

1. In the Layers panel, double-click its existing name 

2. Type the new name, and press Enter 

To group layers: 

1. In the Layers panel, click the first layer to be included in the group 

2. Hold Shift and click the last layer to be included 

3. At the bottom of the Layers panel, click the Create a new group (‘folder’) icon, or 

press Ctrl+G 

4. The group can then be renamed in the same way as layers 

DODGING AND BURNING 

It may be necessary to lighten or darken small areas of the image to refine it. As with most 

things, there are a myriad of ways to do this. 

1. At the bottom of the Layers panel, click Create a new layer 

2. Click Edit > Fill… 

3. Select 50% Gray and click OK 
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4. At the top of the Layers panel, change the layer’s blending mode to ‘Soft Light’ – it 

will seem to disappear (Soft Light only reveals areas that are lighter or darker than 

50% grey) 

5. In the Tools panel, select the Dodge Tool or Burn Tool (press O) as required 

6. Paint on the new layer to lighten or darken where needed 

KEYBOARD SHORTCUTS 
Command/Tool Shortcut 

Crop Tool ........................................................................................ C 

Zoom In ........................................................................................... Ctrl+ 

Zoom Out ....................................................................................... Ctrl- 

Zoom to fit screen......................................................................... Ctrl+0 

Zoom to 100% ............................................................................... Ctrl+1 

Spot Healing Brush Tool .............................................................. J (Shift+J) 

Patch Tool ....................................................................................... J (Shift+J) 

Eraser Tool ..................................................................................... E 

Brush Tool ...................................................................................... B 

Set default foreground/background colours ........................... D 

Switch foreground/background colours .................................. X 

Fill with foreground colour .......................................................... Alt+Backspace 

Fill with background colour ......................................................... Ctrl+Backspace 

‘Fill’ dialog box ............................................................................... Shift+F5 

Group layers into ‘folder’ ............................................................. Ctrl+G 

Dodge Tool ..................................................................................... O (Shift+O) 

Burn Tool ........................................................................................ O (Shift+O) 
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PHOTOSHOP TOOLS 

 

THE LAYERS PANEL 

 

 

Brush Tool 

Spot Healing Brush Tool/Patch Tool 

Dodge Tool/Burn Tool 

Switch fore/background colours 

Lasso Tool/Polygonal Lasso Tool 
Quick Selection Tool 

Reset default fore/background colours 

Crop Tool 

Blending Mode Opacity 

Layer Mask 
Smart Object 

Create New Layer 

Layer Group 

Add Layer Mask 

New Adjustment Layer 


